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Micro Focus Visual COBOL 3.0 for Eclipse
Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Upgrading from earlier Micro Focus products
Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Visual COBOL.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Integration with Eclipse
Application Server JCA support for Enterprise Server
Application Workflow Manager
Application Workflow Manager
Building applications
Character encoding
COBOL language enhancements
Code analysis
Code coverage
Compiler control
Data File Tools
Database access - DB2
Database access - MySQL
Database access - OpenESQL
Debugging applications
Deployment on multiple platforms
Documentation
Enterprise Server
iFileshare
Micro Focus Unit Testing Framework
XML processing

Integration with Eclipse
This release provides enhancements in the following areas:
•

Support for Eclipse 4.6 - Visual COBOL now ships with the 64-bit Eclipse 4.6. By default, Eclipse is
configured to compile applications for 32-bit and the default target platform for new projects is 32-bit.
Note: Applications that were created using Visual COBOL 2.3 Update 2 and earlier must be
recompiled in Visual COBOL 3.0 to ensure they will compile and execute properly.
The 32-bit Eclipse is still supported on 64-bit Windows platforms and you need to manually install the
32-bit IDE and a 32-bit Java

•

•
•

You can install the Visual COBOL plugin in other instances of Eclipse (32-bit or 64-bit). Support for
Eclipse 4.2 and 4.3 has been discontinued.
Rename refactoring - enables you to rename COBOL elements such as variables and identifiers,
section and paragraph names, classes, and methods across a program or a workspace. Renaming
helps improve the readability of an item or make its purpose clearer. Two preferences for renaming are
supported in Eclipse - directly in the editor or using a Rename dialog box that offers a preview.
Copybook paths - it is now possible to specify copybook paths to folders that are outside the project
folder.
Standalone files:
•

It is now possible to specify the locations where the IDE will search for the program symbol files
(.idy) for standalone files: Window > Preferences > Micro Focus > COBOL > Standalone Files
> Program Symbols (.IDY).

What's New
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•

•
•

It is now possible to use the Eclipse debug configurations to debug standalone files, including core
dump files.

In previous versions of Visual COBOL, standalone files were known as "single files". References to
"single files" in the IDE and the product help have been changed to "standalone files".
Error reporting - errors reported in the Console view now include a link for opening the source file at the
line where the error originates.
Editor improvements - an option for removing trailing whitespaces has been added to the IDE
preferences for the COBOL editor.

Back to Top
Application Server JCA support for Enterprise Server
Restriction: This feature applies only when the Enterprise Server feature is enabled.
In this release, EJBGEN has been updated to generate an EAR file as a part of the COBOL deployment
process, which enables you to deploy EJBs to Java Application Server.
Back to Top
Application Workflow Manager
Visual COBOL for Eclipse now provides the Application Workflow Manager (AWM) feature. AWM enables
you to customize and extend the Eclipse UI and workbench functionality to create application workflows
that meet your requirements.
The features comes with:
•
•

A standard project model for local COBOL development that reflects the features available in COBOL
Explorer. You can modify this model by adding or removing project features.
Application Explorer, Filter Definitions, Properties, and Table Results views in the COBOL
perspective.

Back to Top
Application Workflow Manager
This release includes improvements in the following areas:
•

Application Workflow Manager model editor:
•

•

The definition of linked element types and properties has been improved. Some required model
objects and relationships are now generated automatically.
• The editor now detects unused references in a model.
Application Workflow Manager modeling:
•
•

Basic resource processing has been extended to support mass processing where appropriate.
The AWM function package now includes the following new tools:
•

•

•
•
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"Return Property Value" - enables you to map the values of input parameters to output
parameters.
• "Validate Value" - enables you to validate a filename against a specified naming convention.
You can now specify enabling conditions in a more granular way. An additional condition type has
been introduced to hide actions or properties. For example, hiding an action from the context menu
of an element.
The Eclipse linked element type now enables the label and label decorator to be automatically set to
mirror their representation in other Eclipse views if they are not explicitly modeled.
Table columns can be modeled as a combination of two or more properties - for example, to combine
a date and time property value.

•

• Additional standard icons.
Mainframe Access (MFA) integration and the MVS function package:
•
•

•

MVS resources are now available as linked element types.
The following tools have been added to the MVS function package:

• Delete MVS data set or member
• Rename MVS data set or member
• Copy MVS file to clipboard, Paste MVS file from clipboard
• Get data set or member attributes
• Improvements have been made to copy and paste support in the MVS Explorer.
• File mapping between z/OS and local files now supports additional local code pages.
• The editor context menu contains a "Submit to Mainframe" action when a file is opened from the
MVS Explorer with an extension which is mapped to JCL in the File Mappings view.
• Some of the new MVS function package tools replace existing ISPF function package tools resulting
in improved performance of the tools.
• The sample model "MVS Projects Sample Application" has been improved by including some of the
new AWM MVS function package features.
AWM is now available as a standalone feature which you can install into a separate instance of the
Eclipse IDE installed on your machine.

Back to Top
Building applications
This release provides the following improvements:
•

Support for faster, parallel building on multi-CPU machines - support has been added for multiprocessor compilation of the sources in native COBOL projects on multi-CPU machines.
You can specify the maximum number of concurrent compilations from the IDE preferences - Window >
Preferences > Micro Focus > Builder.

Back to Top
Character Encoding
A new utility, cobutf8, is available. cobutf8 enables you to seamlessly run applications that require nonUTF-8 character encodings in a UNIX environment that is using a UTF-8 locale.
Back to Top
COBOL language enhancements
This release includes the following enhancements to the COBOL syntax:
•

The DISPLAY-OF and NATIONAL-OF intrinsic functions are now able to process conversions using any
IBM CCSID value.

The following enhancements are available in managed COBOL:
•

To avoid an exception being thrown if an explicit conversion fails, use the AS IF syntax, which results in
the target object being set to null and no exception thrown.

Back to Top
Code analysis
This release provides the following improvements:
•

A new group of predefined rule sets for 64-bit readiness is now included in Visual COBOL.

What's New
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•

Support for importing code analysis reports produced with one of Micro Focus's advanced tools for code
analysis, Enterprise Analyzer or COBOL Analyzer.

Back to Top
Code coverage
The following improvements are available within the IDE:
•
•
•
•

Information about unexecuted programs - the code coverage reports in the Code Coverage window
now show the unexecuted programs.
Code coverage support for standalone COBOL files - you can import existing code coverage reports in
the Code Coverage window and use it to supply code coverage information for standalone files.
Remote code coverage files - in the Code Coverage window in Eclipse, it is now possible to import
code coverage report files that are stored in remote locations.
Test coverage files - it is now possible to use a test coverage file to debug applications.

If you are using Test Coverage from the command line, you can now use the following features:
•

•
•

A new Compiler directive, COLLECTION - the directive enables test coverage to gather information
about unexecuted programs. In the IDE, this directive is automatically set on a project when you enable
code coverage for it.
A new command line utility, tcutil - the utility enables you to convert the test coverage binary results file
into XML format.
It is now possible to integrate test coverage in a Continuous Integration (CI) system. You can use tcutil
and an XSLT processor to transform test coverage data into a format suitable for including in a CI.

Back to Top
Compiler control
The following Compiler directive are new in this release:
•

COLLECTION - provides a mechanism for code coverage to identify unexecuted programs.

The following Compiler directives have been updated:
•

•
•
•
•

ALIGN - this directive has new parameters (FIXED and OPT) that can be used in conjunction with the
integer taken, which can aid performance. The default is ALIGN"8 OPT"; see the Comments section of
the ALIGN Compiler directive topic for details of its affect on memory boundaries.
ARITH - this directive emulates the IBM mainframe option of the same name. Defines the maximum
number of digits for numeric data items.
FASTINIT - this directive is now on by default when setting the MF dialect; it remains not set by default
for other dialects.
SSRANGE - this directive now has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.
XMLPARSE - includes a change in the way entities are processed when XMLPARSE(COMPAT) is set

Back to Top
Data File Tools
This release provides the following enhancements to Data File Tools:
•

•
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Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.
Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server

•

•
•
•
•

instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.
Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.
This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.
Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.
Support for existing .pro files - enables you to use your existing editor profiles.
Support for existing .str files - enables you to use your existing COBOL structure files.
Automatic timeout - if no internal operations or external actions (such as a mouse click) have been
detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Back to Top
Database access - DB2
This release provides a new DB2(QUALIFY-CALL) Compiler directive that enables stored procedure
invocations to include a schema name.
Back to Top
Database access - MySQL
This release provides support for MySQL with ODBC.
Back to Top
Database access - OpenESQL
This release provides the following new features:
•
•
•
•

Statement prefixes for the SQL(CHECK) Compiler directive that enable the creation of temporary tables
and other SQL objects at compile time, ensuring full SQL syntax checking during compilation.
SQL(OPTIMIZECURSORS) Compiler directive that enhances processing for traditional embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses.
SQL(CLOSE_ON_COMMIT) Compiler directive to leave cursors open for further result set processing
after a commit.
SQL(GEN-SQLCA) Compiler directive that generates an SQLCA similar to the z/OS DB2 directive
STDSQL(YES).

Back to Top
Debugging applications
This release provides the following new features:
•

Debugging core dump files without a project.

Back to Top
Deployment on multiple platforms
This release provides support for deploying JVM COBOL applications on multiple platforms. You can
compile an application on one platform (such as Windows) and then deploy its class files to a different
platform (such as Linux or UNIX).

What's New
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Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications in your product Help for
details.
Back to Top
Documentation
The following new sections have been added to the product help:
•

•

Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.
Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.

Back to Top
Enterprise Server
Improvements are available in the following areas:
Integration with Eclipse:
•
•

Exporting an enterprise server definition from the IDE in XML format.
Importing an enterprise server into the IDE using its definition file.

Long user IDs and passwords:
•

Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

SHA-256 support in DemoCA:
•

By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:
•

Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

Back to Top
iFileshare
iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:
•

An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:
•
•
•
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A primary failover now results in a takeover from the most suitable node.
If configured, external clients will automatically reconnect to the new primary and will issue a
notification if the transaction has been lost.
A failed node, when restarted, will rejoin the group, recover its files and request a log update from
the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.

•

•
•
•

Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.
A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.
The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
The following new iFileshare-specific environment variables are available:
•

•

FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.
• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.
The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds the
entire contents of the data directory to the database reference file.

Back to Top
The Micro Focus Unit Testing Framework
The Micro Focus Unit Testing Framework is now available from within the IDE. It includes much of the
architecture you would expect of an xUnit framework to create, compile, run and debug unit tests, including
the following features:
•
•
•
•
•

A unit test project template.
A test creation wizard that enables you to generate tests from your source code.
Code templates for each element of a test case.
Support for running tests with Code Coverage enabled.
The Micro Focus Unit Testing view, where you can manage your test runs and view test output.

There has been a number of enhancements to the command line version of the Micro Focus Unit Testing
Framework. Support has been added for:
•
•
•
•
•

Running test fixture files using Apache Ant.
Applying traits to your test cases, then performing a test run based on those traits.
Applying a high, medium, or low priority to test cases, which affects the order in which they are run.
Adding coded command line options directly into your test code.
Using a test run-specific configuration file, in which you can set environment variables.

Back to Top
XML processing
XML PARSE now works in a purely managed COBOL environment. It is now supported in JVM COBOL
and, in both .NET and JVM COBOL, it has a fully managed implementation. XML PARSE working without
calling out to native code ensures it can be used in restricted rights environments.
Back to Top

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•

Compatibility AddPack
Compiler
Documentation
Enterprise Server
File Handling
IDE
Micro Focus Directory Server
OpenESQL
Reserved words
SQL Option for DB2

Compatibility AddPack for Visual COBOL
Back to the list
Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.
The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Visual COBOL for Visual Studio. The
run-time components are installed as part of COBOL Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.
The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.
Compiler
Back to the list
•

Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.
2869185 (1105763)

Documentation
Back to the list
•

There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server
Back to the list
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•

WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.
2989188 (1108602)

IDE
Back to the list
•

•

You can now open data files in RSE configured remote projects using the mfdatatools2 on the remote
machine displaying back to an X display. You can configure the remote tools display by clicking Window
> Preferences > Micro Focus > X Display. In the X Display (DISPLAY) field, type the display details. In
addition, COBOL Explorer displays the Open With Remote Data File Editor context menu item for
remote data files.
2852872 (1104085)
Enterprise Server sign on credentials which were created on Windows when using the 32-bit versions of
Enterprise Developer or Visual COBOL for Eclipse are not compatible with the 64-bit versions of those
products, and vice versa. Users are required to re-enter credentials which are not compatible with the
current version of the product. You only need to do this the first time they are used in the current
product.
(625819)

File Handling
Back to the list
•

•

Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.
2988222 (1108521)
A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.
2874622 (1106562)

Micro Focus Directory Server
Back to the list
•

•

In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.
3101625 (1109025)
Some additional CSRF security measures have been added to the Enterprise Server Administration
HTML GUI.
3101205 (1108916)

OpenESQL
Back to the list
The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for ODBC
(DBMAN=ODBC). This ensures that embedded SQL cursors that use WITH HOLD and FOR UPDATE
clauses have the same data integrity across all databases.
If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

Significant Changes in Behavior or Usage
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Reserved words
Back to the list
•

There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:
ALLOCATE
FREE
JSON
END-JSON

SQL Option for DB2
Back to the list
•
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Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.

| Significant Changes in Behavior or Usage

Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•
•
•

Debugging
Enterprise Server
Eclipse
Resource Adapters
REST/JSON IMTK implementation and the same-origin policy (SOP)

Debugging
•

When debugging .gnt code on early builds of Windows 10 and Windows Server 2016, execution fails
to stop at COBOL breakpoints. To resolve this, you should install the most recent Windows updates for
your operating system, as this problem is only known to be present with the earlier versions.

•

When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.

•

You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.
Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:
1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

•

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
<DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>
3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.
4. Start Eclipse from the same command or shell prompt.
Remote debugging does not work for programs running on AIX or HP machines, if you are trying to
debug using Visual COBOL installed on a Linux machine.

Enterprise Server
•

On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Known Issues

| 15

Eclipse
•

Opening a COBOL project in Visual COBOL modifies the .cobolProj file. Once modified
the .cobolProj file is no longer backward compatible with older versions of Visual COBOL. This
prevents you from opening the same projects in earlier versions of Visual COBOL.
Note: Micro Focus recommend that you backup your .cobolProj file before opening projects
created in earlier versions of Visual COBOL.

Resource Adapters
•

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)
•
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HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Application Workflow Manager
Character Animator
COBOL to XML Schema generation
Codeset Support
Common Communications Interface
Compiler
Data Tools
Debugger
Documentation
Editor Writing Assistance
Embedded HTML Pre-Processor
Enterprise Server
File Handling
IDE
Interface Mapping Toolkit
Micro Focus Directory Server
Monitoring and Management
OLE Class Library
OpenSSL
REX Support
RM/COBOL
Run-Time System
SQL: COBSQL
SQL: OpenESQL
SQL Option for DB2
XML Support

Adis
Back to the list
•

PIC N items are now filled with double-byte space when required by ADISCTRL options 15 and 16.
2913183 (1108448)

Application Workflow Manager
Back to the list
•

AWM tree tables now show element properties of non leaf elements.

•

2875325 (1106680)
A new "Show Progress Monitor" model attribute for action descriptors is now available. It allows you to
control whether a progress monitor dialog is displayed while an action is being executed.
2611122 (1087640)

Resolved Issues
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•
•
•

Improved AWM performance with large element lists.
Affected resource contexts are now persistent and keep the output parameters received from other
tools. This functionality must be enabled manually in older models from the application options.
Model enabled conditions now use returned tool output parameters if available.

•

2879746 (1107245)
Sub-menus are now created for modeled AWM Global Editor Actions.
2877404 (1106916)

Character Animator
Back to the list
•

The Break>Cancel-All option no longer occasionally freezes the Animator.
2879817 (1107460)

COBOL to XML Schema generation
Back to the list
•

CBL2XML now handles namespace correctly.

•

2861655 (1104748)
CBL2XML now correctly handles non-default type within <restriction>.
2826345 (1100279)

Codeset Support
Back to the list
•

The Codeset DBCS tables MFTR0886.A2E MFTR0886.E2A have been updated to match the latest IBM
Traditional Chinese conversion tables below: Description of 9027: T-Ch Host Double-Byte including
6204 UDC including euro. Description of 21427: T-Ch DBCS-PC (IBM BIG-5) including 13493 CNS, 566
IBM selected, 6204 UDC & euro.
3104948 (1109314)

Common Communications Interface
Back to the list
•

•

Using CCI shared memory and receiving data with a max receive length less than the total amount of
data received resulted in the data being received incorrectly on the final receive. This has now been
fixed.
After a communications failure, Enterprise Server shared-memory listeners would sometimes stop
accepting new connections. This has now been fixed.

Compiler
Back to the list
•

•

•
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Level-88 VALUE clauses that inadvertently contain fixed point numeric literals, which cannot be
matched with the associated numeric type, are now flagged with an E-level message.
3106909 (1109479)
A new ARITH"COMPAT|EXTEND" Compiler directive is now supported to emulate the IBM mainframe
option of the same name. This option defines the maximum number of digits for numeric data items.
3105597 (1109340)
An extended ACCEPT of a PIC N data item now compiles successfully, as expected.

•

•

•
•

3101615 (1108944)
The reference to an ASSIGN name in the SELECT clause is now included in the IDE's 'Find All
References' list irrespective of whether the ASSIGN name is explicitly declared later in the source or
not.
3100084 (1108817)
When an intrinsic function is used as a parameter to an inline method invoke, which is also a parameter
to another inline method invoke, the Compiler would produce invalid code, leading to a COBRT200
error. This is now fixed.
2991106 (1108786)
Prototype checking for OMITTED parameters in inline method invokes is now working as expected.
2991031 (1108800)
An error when an OBJECT PROPERTY is used in subscript calculation, or reference modification index
or length calculation, has been fixed.

•

2990388 (1108738)
A directives file with an explicit end of file character is now processed correctly.

•

2913115 (1108474)
A DISPLAY of ADDRESS OF <data item> now executes as expected.

•

2913005 (1108635)
Prototype checking for nested inline method invokes is now working as expected.

•

2912463 (1108437)
A bug where compilation of very large managed projects could fail with error "COBCH1500: memory
allocation failure – module 'allocmem'" has been fixed.

•

2886156 (1108156)
Using COBSQL with CP for a program with complex multi-line COPY REPLACING no longer results in
spurious errors.

•

2884493 (1107939)
A move from a group to a reference modified PIC N field now executes as expected.

•

2884093 (1107883)
Producing a test coverage report in Eclipse no longer gives an exception for SQL programs with ENTRY
statements.

•

2882106 (1107558)
Sign-included numeric usage DISPLAY items now display as expected under a mainframe dialect; that
is, they display with the included sign shown exactly as stored, without conversion for readability.

•

2879364 (1107340)
The use of N" national literals in STRING statements no longer produces incorrect results.

•

2878504 (1107053)
A bug where COBDATA was set prior to starting the Visual Studio IDE, and was then blank when
applications were executed, has been fixed.

•

2878431 (1107160)
A user class condition where the subject has the potential to be zero length now compiles and executes
as expected when compiled with a mainframe dialect (which sets the ZEROLENGTHFALSE directive).

•

2878426 (1107044)
The same names used for data items in both method local and object storage could sometimes result in
wrong execution results when the wrong duplicated name was used.

•

2878370 (1107207)
Class conditions defined in the SPECIAL-NAMES paragraph now work when SELECT statements are
defined before the SPECIAL-NAMES paragraph.
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•

•

2876808 (1106853)
Under CHARSET(EBCDIC), a MOVE of PIC G/N data items to PIC N/G data items now pad with
x"4040" (an EBCDIC DBCS space). Comparisons of such data items will now also work correctly.
2876109 (1106752)
VALUE clauses with hex literals now pad correctly with x"40" under CHARSET(EBCDIC).

•

2875748 (1106704)
Statements involving properties and 'OCCURS DEPENDING ON' tables now compile and execute as
expected.

•

2875074 (1106626)
Concatenation of alphanumeric literals in a VALUE clause for a national item is now treated as
intended.

•
•

•

2873871 (1106451)
Queries of reference modified national data items now work as expected.
2873639 (1106443)
Using INSPECT <national-data-item> with the BY SPACE clause now works as expected. When dealing
with national data items, SPACE is now treated as a national space - NX"0020£.
2873388 (1106390)
A user class condition test, where the item being tested is a reference modified item with a length that is
an expression, and when the directive ARITHMETIC(OSVS) is set, no longer causes an internal error
on compilation.

•

2873219 (1106409)
Nested inline method invokes now work as expected.

•

2872741 (1106315)
A MOVE statement referencing a property name now compiles and executes as expected.

•

•

2872488 (1106304)
A program containing DBCS characters in the sequence area of an otherwise blank line now compiles
correctly and without error.
2868802 (1105699)
An issue with using DECLARATIVES without a USE statement has been fixed.

•

2867168 (1105446)
If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then
under HOSTRW, the record length was wrong. This has been corrected.

•

2865849 (1105553)
The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of
lines in a report produced from the Report Writer.

•

•
•
•

2853789 (1105472)
A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where
the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.
2433731 (1073167)
A bug in the Compiler, when REPLACE is used and the final line in the main source file is a copy
statement containing a separate program, has been fixed.
An error reporting the size of return-code by the Eclipse IDE has been fixed.
A bug has been fixed in programs compiled with CHECKDIV"OSVS" that contain a statement of the
form: COMPUTE r = a / (b - b)
3105637 (1109410)

20

| Resolved Issues

•
•

•
•

•
•

•

A bug in ON SIZE ERROR for arithmetic statements using floating point variables has been fixed.
2886077 (1108151)
A bug has been fixed in generated code on Linux/390 for statements of the form: compute rounded a =
b / constant where a and b are both comp-3 variables, and constant is an integral power of 10 (e.g. 10,
100, 1000).
2874143 (1106479)
A COBRT114 error that was occurring at run time in generated code has been fixed.
2871410 (1106100)
An error in debugging on Intel 32-bit platforms, such that a breakpoint set on an "exit method" statement
is ignored if it immediately follows a statement such as "end-perform", "end-if" or "end-evaluate", has
been fixed.
2861424 (1104587)
A bug in generated code with the opt(3) directive, on Intel x86 64 bit (Linux and Windows) and
Linux/390 has been fixed.
For programs compiled with JVMGEN, the directive HOSTFD is not currently supported, and is
switched off by the Compiler. However, for programs compiled using the ILSOURCE directive, this
switching off did not happen, and as a consequence, bad code was generated that led to exceptions at
run time - this has now been fixed.
3103829 (1109174)
Debugging is now working correctly for JVM COBOL programs where the PROCEDURE DIVISION
spans more than 65535 lines.
3102742 (1109264)

Data Tools
Back to the list
•

Vision and RM files that contain a null (0x00) byte in the key now function correctly in the Data File
Editor.
2882159 (1107598)

•

The following minor enhancements have been made to the Data File Editor: - Previous filter conditions
are now remembered for each file when the dialog is loaded. - The default filter operator now defaults to
'Contains'. - Field attributes for reference conditions now default to 1:max-rec- length, instead of 1:1.
2878521 (1107104)

Debugger
Back to the list
•

Querying DBCS items in Character Animator now works as expected.

•

3107408 (1109521)
The debugger no longer hangs when debugging remote Enterprise Server regions.

•

2882367 (1107659)
Examining the value of large data items in 64-bit applications or when debugging remote applications
no longer causes the debugger to exit.

•

2872732 (1106322)
When debugging a remote COBOL program on Linux from Eclipse, you no longer encounter a spurious
RT 115 Signal 5 fault.
2852872 (1105048)
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•

When debugging .gnt code, execution fails to stop at COBOL breakpoints. To resolve this, you should
install the most recent Windows updates for your operating system, as this problem is only known to be
present with early Windows builds of both Windows 10 and Windows Server 2016.

•

COBOL JVM programs consisting of more than 65534 total lines can now be debugged in Eclipse
provided that the total number of lines after the first line of PROCEDURE DIVISION code is less than
65535 lines.
2885726 (1108172)

Documentation
Back to the list
•

A new error message, STA0011E, has been added to the zServer Messages and Diagnostics.

•

3109473 (1109751)
The product documentation has been updated to include information and syntax for secure access to
MFDS (mfds /b).

•
•

2854625 (1103606)
Documentation for environment variables has been improved.
The casstart /w parameter prevents the casstart process from exiting until the region has either started
or failed to start correctly.
2868898 (1105712)

•

A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes

•

2989911 (1108665)
Additional information on the Web Services and J2EE conversation type has been added to the
"Configuring Listener Conversation Types" chapter in the product documentation.

•

2877270 (1106896)
The product documentation has been updated to include information on converting the input file used by
casrdtup from EBCIDIC to ASCI.

•
•
•

2863611 (1104940)
The documentation for bit zero of the 'thread-state' parameter of CBL_THREAD_LIST_START and
CBL_THREAD_LIST_NEXT has been corrected.
Documentation of CBL_LOCATE_FILE parameter corrected.
The installation instructions included incorrect information about users having to stop and uninstall an
existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a
process (on UNIX) from an existing product. This has been removed from the product help.
2877431 (1106934)

Editor Writing Assistance
Back to the list
•

IntelliSense and Content Assist now provide the appropriate suggestions after a CONTAINS expression.

Enterprise Server
Back to the list
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•

An issue where SOAP elements were not mapped to COBOL code has been resolved.

•

3106199 (1109416)
When SOAP headers were part of the SOAP request, you no longer receive a "SOAP header
malformed" response.

•

3105803 (1109367)
An issue where a handler program in the pipeline caused issues with JSON GET/DELETE/HEAD
requests has been fixed.

•

•

•

3104977 (1109274)
An UNDEFINED_ELEMENT error message occurred when a JSON message (under CICS WEB
SERVICES) did not include an object that was present as a "record 1" item in the wsbind or the jsbind
files.
3102943 (1109085)
When a CICS Web Service was invoked with no port in the URI, the default port for the scheme was not
set up.
3100280 (1108870)
EXEC CICS SEND and CONVERSE commands now send all user-written headers (EXEC CICS
WRITE HTTPHEADER) even if the user provided values that contain null bytes. When browsing
headers with EXEC CICS WEB READNEXT HTTPHEADER, CICS will now initialize the buffers that
were supplied for the header name and value.

•

2990561 (1108733)
A problem where a system process (CASTRC) was unable to allocate any local storage and, as a
result, became unresponsive, has been resolved.

•

2886741 (1108236)
Casout commands running in a loop from the same process used to exhausting resources. This was
caused by an invalid path concatenation.

•
•

2886407 (1108426)
An issue resulting in a Run-Time System error 205 "Invalid mainframe pointer" has been fixed.
2885280 (1108041)
TRANSFORM was failing in situations where an XMLTODATA TRANSFORM contained an XML
declaration with EBCDIC encoding.

•

2885262 (1108040)
The EZASOKET traces are now controlled by a COMMS trace flag.

•

2884491 (1108174)
Caching has been added for TS queues security checks.

•

2884070 (1108789)
Commarea overrides are now honored for non-facility transactions.

•

2884049 (1107879)
Usernamelen and passwordlen options are not mandatory on exec cics web converse and web send
(client).

•

2880669 (1107365)
Previously, using multiple CICS LINK statements (linking A to B to C and so on) could result in an RTS
error 114 in the CAS system modules.

•

2880542 (1107372)
The spool active job queue will now display any jobs that were started prior to resetting the time for DST
but that have not completed yet.
2879116 (1107204)
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•

•

•

The debug file name generated when using CICS Web Services now includes the process ID and the
task number. For example - inquireCatalogClient-19556(00028)-CWS-REQUESTER.TXT.
2878485 (1107077)
The SOAP to COBOL mapping under CICS Web services was incorrect when an optional element had
no child elements (where the schema defined a minimum of one such child element and these child
elements have been mapped to a container). In such cases, the number of instances of the child
element would have an incorrect value of 1 where it should be 0.
2877043 (1106879)
If you used XA with more than 7281 transactions or had a number of JCL jobs that used XA, a record
could be split across multiple blocks. After restarting the enterprise server, a large number of
CASXO0029I errors were reported in the console log file. A block that can hold up to 7282 records is
now used.

•

2874024 (1106469)
When casout is used to release a job, casmgr now attempts to dispatch the job immediately rather than
waiting for its next dispatch cycle which previously could take 20 seconds.

•

2873224 (1106621)
If there were more than 20 TRANCLASS instances specified in the startup list, this could cause
memory corruption.

•

2868129 (1105682)
The ESFCA0401I Cache Termination message is now available for JES, IMS DB, IMS TM, MQ, and
iFileshare processes.

•

2866750 (1105376)
A duplicate security check about whether the user has enough permissions to run a JCL job has been
removed.

•

•

•
•

•

2866526 (1105336)
When eci-tpn is used on a call to ECI for CTG or the Micro Focus implementation of ECI, Enterprise
Server now verifies the transaction exist and is enabled. If the transaction is disabled, an abend AZI6 is
returned. This is mainframe-compatible behavior.
2863500 (1105165)
An EXEC CICS LINK to a non-CICS module now handles the data context correctly and you no longer
receive CDCD abends on any further LINKs.
2858747 (1104275)
CASxx5006I messages now display a return code.
2853609 (1103516)
All ESMAC pages are now secured. Users who are not authorized now receive an error message when
trying to access any of these pages in their browser.
2843901 (1102247)
The CICS WEB services now support SOAP 1.2.

•

2822822 (1099723)
An issue that could cause an RTS error 119 on a casout command when starting a batch initiator has
been fixed.

•

An issue with certain length DNs that could cause DNs to become truncated has now been fixed.

•

3103303 (1109366)
If nested groups (user groups containing other groups) were used with LDAP-based security for
Enterprise Server, it could result in Enterprise Server hanging at region startup, or users might not be
assigned all of their groups. This has now been fixed.
2988205 (1108935)
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•

•

•

•

The "check TLQ first" option has been added to the MLDAP ESM. The option can change the Rule
processing algorithm. This option might improve performance when there are large numbers of
resources in a class.
2875051 (1106874)
Enterprise Server no longer crashes on startup if LDAP-based external security with the "all-groups"
and "redundant" options are both specified, but the "federated groups" option is not.
2874010 (1106529)
If the esfupdate utility is used to request an update of security information for a user, and that user was
originally signed onto the system using a lowercase representation of their user ID, the update now
correctly identifies and updates the user.
2871297 (1106164)
If the MFDS Security Configuration specifies that verify requests should be cached and the cache TTL
and limit values are non-zero, for example, the MF Directory Server Security configuration page
Security Facility configuration text contains: [Cache] requests=verify If a new password was specified in
a Web interface logon request, then previously it was being ignored. Previously, if the user was logging
on with an expired password and attempting to change the password the request would also be ignored
and an expired password error would be returned.
2868342 (1105626)

•

An RTS 205 error during the execution of an AMODE application could occur when Assembler address
0 was erroneously de-registered. This is now fixed.
3104561 (1109229)

•

Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.
2863222 (1104948)

•

•

Enterprise Server listeners that are configured for TLS (also known as SSL) no longer hang if a client
connects to them without sending any data.
2873177 (1106408)
In some HotFix releases of earlier versions of Enterprise Developer and Enterprise Server, SSL or TLS
connections to an Enterprise Server could hang if client certificates were used and there was a delay of
at least several seconds before the certificate was sent.

Embedded HTML Pre-Processor
Back to the list
•

The XML run-time system did not handle data items with the OCCURS clause correctly.
3107418 (1109566)

File Handling
Back to the list
•
•

•

The ESF LDAP Security Administration Web Interface now has a logoff button.
2871551 (1106117)
If data compression is specified when trying to open a fixed block file, when running under a mainframe
dialect, the File Handler now checks to see if it is trying to open a VB file. If it isn't, compression will be
turned off and the file will be opened as normal.
2870022 (1105956)
An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.
2868664 (1105707)
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•

When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler
was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.
2864802 (1106106)

•

•

A CBL_FREE_MEM statement in Fileshare was missing a 'by value' clause, which was causing a runtime error. This is now fixed.
2883421 (1107767)
When running under Fileshare, a delete on a locked record no longer results in a record locked status if
the same user had previously obtained a read lock on the file.
2832909 (1108287)

•

When REBUILDing from SEQ into IND with duplicate key, you will no longer get a corrupted file if you
do not specify the target flag /t.
2880311 (1107302)

•

CSF to ZD negative sign conversion is now handled correctly during a sort operation.

•

3103118 (1109125)
JCL SORT no longer abends if no record is rewritten to a DUMMY data set.

•

3102468 (1109052)
Sorting ESDS files to RRDS files no longer truncates the first 4 bytes of each record.

•

•

3101385 (1109112)
Variable length SORT OUTFIL files are now created correctly when more than one data set is specified
in the targeted OUTFIL.
2881629 (1107551)
MFSORT INCLUDE will no longer include the first record in the concatenated file if, according to the
parameters, that record should be excluded; previously, the first record was included regardless of the
parameters.

•

2876259 (1106785)
For an MFJSORT, a combination of numeric tests and logical comparisons now returns the correct
records.

•

2870986 (1106216)
When copying concatenated files in MFJSORT, for sequential fixed block, the correct number of record
is now used.

•

2870506 (1106057)
MFJSort now produces the correct number of records regardless of the value of the SORTSPACE
setting.

•

2867668 (1105534)
An error when writing the ICETOOL listing from an empty input file has been corrected.
2866176 (1106459)

IDE
Back to the list
•

An %INCLUDE statements inside EXEC SQL blocks no longer cause the background parse to hang.

•

3106015 (1109413)
A literal inside an EXEC SQL block that contains a % symbol is processed correctly by the background
parser.
3105706 (1109385)
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•

A literal inside an EXEC SQL block that contains a ':' symbol no longer causes the background parser to
hang.

•

3105705 (1109381)
Spaces that cross the right margin are trimmed on the lines that are pasted into the PL/I editor.

•

3103484 (1109156)
The JCL editor no longer reports PDS names that contain keywords as errors.

•

•

2988662 (1108553)
Include files can now be opened in the Include Dependency view either by double-clicking the include
file or by right-clicking the include file and choosing Open from the context menu.
2887972 (1108594)
Background parse is no longer performed for VSE JCL programs.

•

2886880 (1108245)
Pressing the Home or End keys when Eclipse editor code blocks were collapsed resulted in the cursor
moving to an incorrect location.

•

2884211 (1107905)
Debugging source lookup performance has been improved when the "Search sub-folders" option is
used with a remote file system directory.

•

2882252 (1107658)
The format clause of the PUT statement is now supported by the background parse in the PL/I editor.

•

2882206 (1107578)
Opening a SourceConnect copybook no longer displays a Context Lost error dialog.

•

•

2882175 (1107611)
The PL/I %INCLUDE statements of the form "%INCLUDE (filename );" no longer cause errors in the
editor if the filename is followed by a space character.
2881410 (1107478)
The PL/I keywords LIMITED ENTRY and ALIAS are now supported by the background parser.

•

2881035 (1107480)
PL/I variables defined using macro preprocessor facilities no longer cause error messages in the PL/I
editor.

•

2879794 (1107332)
It is now possible to successfully background parse a non-JVM COBOL program that requires use of a
preprocessor whilst using either 32-bit or 64-bit build configurations.

•

2879008 (1107155)
PL/I variables defined using the macro preprocessor facilities no longer cause error messages in the
PL/I editor.

•

2874348 (1106612)
Lines are now wrapped in the PL/I editor after using the Find/Replace dialog.

•

2874166 (1106509)
A PL/I program opened with 'Browse' in the Team Developer view cannot be modified in the PL/I editor.

•

•

2874071 (1106501)
COBOL editor functions such as Go To Definition now work with programs containing REPLACE
statements that generate additional source lines.
2873287 (1106406)
Copybook dependencies are now shown correctly within Eclipse for 64-bit compilations.
2866406 (1105576)
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•
•

•

A PL/I macro invocation used as a statement parameter is no longer reported as an error.
2862571 (1104763)
The performance of the "Updating Micro Focus model" job, user interface responsiveness and memory
consumption have been improved when folders containing large numbers of files are added to an
Eclipse project.
2856154 (1105184)
Lines are now wrapped in the COBOL editor after using the Find/Replace dialog.

•

2856003 (1103827)
The ES_SERVER environment variable is now correctly resolved when viewing the console log or
catalog in the Server Explorer view.

•

2852734 (1103371)
A problem with the core Eclipse code could cause a full project rebuild to occur when not required. This
has now been fixed.

•

2816310 (1104735)
Dependency folders can be sorted based on the order they are specified on the Build Path property
page.

Interface Mapping Toolkit
Back to the list
•

•

A problem with Enterprise Server that caused an alphanumeric data item mapped to a SOAP Boolean
to give results that were incompatible with the mainframe for invalid data values has been fixed.
2887795 (1108360)
Client generation now works as expected when invoked from the Team Developer Tree View.
2869050 (1105758)

•

The performance of a COBOL Web client has been improved when processing services with interface
parameters containing unbounded arrays.
2884760 (1108026)

•

•

When a path specified as part of an ls2ws parameter contained at least one space, ls2ws would fail.
This has been fixed.
(622294)
EJB generation/deployment has been enhanced to produce an EAR file. Unlike the EAR file produced
during client generation, this deploy-time EAR does not contain a WAR file and thus does not contain
any JSP files.

Micro Focus Directory Server
Back to the list
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•

Fixed a memory leak in the MFDS process.

•

2876419 (1106799)
A memory leak in the MFDS process occurred if non-SSL-enabled connection attempts were made
against an SSL-enabled MFDS. This has now been fixed.

•

2869493 (1106567)
The MFDS -g command-line option now correctly handles the import of multiple region definitions from
a single XML file.

•

2840162 (1101798)
An issue that could potentially cause heap corruption in MFDS if the configuration data for an individual
object was greater than 1K has been fixed.

| Resolved Issues

•

The "Renew" option available in the Enterprise Server Administration Web interface now works if SSL is
enabled.

Monitoring and Management
Back to the list
•

•

Spurious STEP BYPASSED events for dummy steps were being passed to the user exit and the HSF
exit.
2873504 (1106446)
An issue where duplicate HSF records could be created has been fixed.
2856941 (1103977)

OLE Class Library
Back to the list
•

A problem with accelerator keys being handled by an ActiveX control has been fixed.
2990224 (1108719)

OpenSSL
Back to the list
•

The version of OpenSSL included in this product has been updated to version 1.0.2j.

REX Support
Back to the list
•

•

When running a REXX EXEC under Enterprise Server or Enterprise Server for .NET, an "Invalid
Expression" error occurred for an assignment statement where the expression being assigned to the
variable had been omitted. An empty string is now assigned to the variable if the expression is omitted.
2880655 (1107390)
A REXX exec could fail with a S0C4 abend or an RTS 114 error if it was greater than 4096 bytes in
length and specified either as in-stream data or catalogued as an RECFM=F or RECFM=V dataset.
2878613 (1107100)

RM/COBOL
Back to the list
•

When FILETYPE(21) was specified for a LINE SEQUENTIAL print file, you could receive a Run-Time
System error "13". Writing to a printer from a Visual COBOL program through the RM File Manager
(filetype 21) now works correctly.
2874987 (1106616)

Run-Time System
Back to the list
•

•

Adis SCREEN SECTION ACCEPT statements for PIC N DISPLAY-1 items now correctly accept DBCS
characters with a lead byte of x"87".
3104586 (1109231)
A error when using very long command lines with Profiler (or cobprof on UNIX) has been fixed.
2884968 (625185)
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•

•

•

•

•
•

You can now double-click (to run) managed executables that use the ACUFH file handler; previously,
they may have failed with a COBRT198 error.
2880827 (1107388)
When debugging a native Object COBOL application, the debugger no longer fails with an intermittent
COBRT114 run-time error when getting the type and value of an object's handle.
2875531 (1106808)
A multi-threaded application that makes use of the COBOL syntax for handling mutexes, monitors,
events and semaphores, or the corresponding CBL_ APIs, no longer fails intermittently with various runtime errors due to memory corruption.
2860205 (1104446)
Animating a core file that has been moved to a different directory, for a core file produced by an
application compiled to executable, no longer fails with a "Program is not animatable" error. Previously, it
would on certain platforms.
2856631 (1103933)
Detaching from animation that was started using the debug_on_error tunable could cause animation to
re-start again for the initial error - this has now been resolved.
A 12-byte (32-bit) memory leak has been prevented when calling native COBOL code from JVM
COBOL when using the 'C' call-convention, or the RuntimeSystem.cobcall/cobrcall library APIs, with a
parameter type that is a JVM array.

SQL: COBSQL
Back to the list
•

A problem that caused the COBSQL preprocessor to incorrectly parse comments beyond column 72
has been fixed.

•

3101746 (1108980)
A problem with COBSQL producing a duplicated cursor data item when KEEPCOMP was used has
been fixed.

•

2874051 (1106531)
A problem that caused the COBSQL preprocessor to incorrectly process source lines with characters in
column 73 and beyond has been fixed.
2869958 (1109899)

SQL: OpenESQL
Back to the list
•

•

•

The OpenESQL preprocessor incorrectly expanded a group host variable used in a CURSOR SELECT
statement, resulting in a run-time error. The preprocessor has been modified to generate a COBES0130
error message in this case.
3104602 (1109289)
A problem the prevented OpenEQL applications calling SQL Server stored procedures with no
parameters when using the legacy 'SQL Server' ODBC driver has been fixed. Important: We strongly
discourage use of the legacy 'SQL Server' ODBC driver. Instead, we recommend that for best
performance and functionality, use the ODBC driver that corresponds to the version of SQL Server used
by the application.
3100550 (1109071)
A problem with HCOSS code generation that occurred when duplicating input host variable references
(for example when substr() is used with 2 rather than 3 parameters) has been fixed.
3100098 (1108819)
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•

•

•

•
•

A problem with the OpenESQL native routine that provides DSNTIAR emulation sometimes caused an
RTS114 error. This has been fixed.
2989595 (1108699)
A new OpenESQL directive, GEN-SQLCA, has been added to generate the SQLCA copybook in a
program when it has not been explicitly included. This directive provides additional support when
migrating applications compiled with STDSQL(YES) on the mainframe.
2887858 (1108368)
A problem with the MSSQL XA switch module sometimes causing a CICS transaction to abort if it
ended without closing all FORWARD and READ ONLY cursors has been fixed.
2887074 (1108340)
An inconsistency in reporting data truncation warnings when using PostgreSQL has been fixed.
2886648 (1108201)
OpenESQL and OCI have been updated to to prevent RTS198 errors when using DSNTIAR with
ODBC. To take advantage of this new functionality, specify the cob -d command flag to resolve
DSNTIAR with the correct callable shared object. For example, to compile a COBOL program into an
executable on a 64-bit platform with OESQL DSNTIAR: cob -x program.cbl -d
DSNTIAR@cobmfdsntiar64.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm Or, to compile a PL/I
program into an executable on a 32-bit platform with OESQL DSNTIAR, execute the following two
commands: mfplx -c PROGRAM.pli -sql odbc -optsql "behavior=mainframe nosmftrace" cob -x
PROGRAM.o -d DSNTIAR@cobmfdsntiar.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm

•

2884651 (1107997)
A problem when using OpenESQL for JDBC with the "Use Dynamic Calls" project option has been
fixed.

•

2883500 (1107955)
A problem with SQL(AUTOFETCH) that affected SQL Server FORWARD READ ONLY WITH HOLD
cursors performance has been fixed.

•

2880840 (1107580)
The ADO.NET Run-Time System for OpenESQL now returns the correct value in SQLERRD(3) after a
cursor fetch when other statements are executed between any fetches on the cursor.

•

2880814 (1107386)
OpenESQL now allows FREE to be used as an SQL identifier. It is server dependent if this is supported
at compile time when using SQL(CHECK) and at run time.

•

2880673 (1107368)
A new OpenESQL directive, CLOSE_ON_COMMIT, has been added to provide greater control over
cursor behavior on COMMIT for cursors that are not explicitly declared using WITH HOLD.

•

2879558 (1107305)
A problem with HCOSS handling of nested table references in DB2 statements has been fixed and error
messages when using SQL(STRICTPARSE) have been improved.

•

•
•

2879503 (1107286)
The SQLBGP COBSQL compiler directive option has been added to ensure successful background
parsing of EXEC SQL statements when the Pro*COBOL installation resides on a remote machine and
not on the local machine.
2877618 (1107292)
A problem that prevented SQL(CHECK) from working correctly on some databases has been fixed.
2877284 (1107021)
When used with the SQL(USER-SQLDA=MAINFRAME) directive, the OpenESQL preprocessor could
incorrectly generate ES0100 errors if a group variable was used in an EXEC SQL FETCH statement.
This has been fixed.
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•

2876420 (1106803)
The OpenESQL preprocessor sometimes failed to return comp data items correctly if compiled with
SQL(DIALECT=MAINFRAME). This has been fixed.

•

2874931 (1106606)
The OpenESQL preprocessor has been updated to generate a more meaningful message,
COBES0129, when it encounters an undefined host variable.

•
•

•

•

•

•
•

•
•

•

2874408 (1106624)
A problem with SQL(NORSLOCATORS) leaking SQL Server server cursors has been fixed.
2872613 (1106294)
HCOSS handling of the DB2 CHAR() function did not always properly apply the compile-time settings of
DATE and TIME as the default formats when CHAR was called with a date or time value but no date or
time format parameter was supplied. This has been fixed.
2872518 (1106404)
A new SQL compiler directive option, OPTIMIZECURSORS, has been added to optimize memory
consumption when using OpenESQL for ADO.NET with Oracle, DB2, or PostgreSQL. The default
setting is SQL(OPTIMIZECURSORS=YES). See the OPTIMIZECURSORS reference topic in the
documentation for complete information.
2871132 (1106056)
Decimal and host variables with the same length are now converted to EBCDIC correctly when
CHARSET(EBCDIC) is enabled; however, if you link native COBOL applications that use display
numeric variables in SQL statements using CHARSET(EBCDIC), you might get a link error. To resolve
this issue, see the OpenESQL topic under Known Issues and Restrictions.
2857755 (1104091)
A problem with the ODBC switch module not reporting broken connections to Enterprise Server when
xa_start() is called has been fixed.
2843672 (1108847)
A problem that caused the OpenESQL preprocessor to incorrectly interpret UNICODE(PORTABLE) has
been fixed.
The SQL xa_open string has been updated to include the PACKAGEPATH option, which enables the
use of substitution markers to customize the package path based on the current JCL or CICS user
name, XA resource name, enterprise server region name, or a combination. In addition, when used with
the UserP option, the PACKAGEPATH option value changes when the user for the connection changes.
A problem using SQL(DATEDELIM) with SQL(DATE=JIS) has been fixed.
OpenESQL has been updated to enable execution of selected SQL statements at compile time. You can
use this functionality to create temporary tables during compilation and to enable the use of
SQL(CHECK) with temporary as well as permanent tables.
The encoding of the sqltype fields in SQLDA has changed and any applications that use dynamic SQL
with SQLDAs might require application code change. The new sqltype encoding scheme adds 0x2000
to sqltype when an integer, a small integer or a big integer host variable is COMP and 0x1000 and when
any indicator host variable is COMP. Otherwise, COMP-5 is assumed for indicators and for integer,
small integer and big integer host variables.

SQL Option for DB2
Back to the list
•

A problem with the Declaration Generator that prevented COBOL copybooks from being generated
correctly for tables with timestamps and XML columns has been fixed.
2875742 (1106868)

•
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The XDB preprocessor has been updated to support source connect files that previously generated a
"File not found" error for EXEC SQL INCLUDE statements located on the source connect drive.

•

2912819 (1108471)
The XDB ECM has been enhanced to handle temporal table query syntax.
2876438 (1106807)

•

Implemented the JDBC ResultSet Interface getBigDecimal methods that do not require a scale
argument: getBigDecimal(int columnIndex) and getBigDecimal(String columnLabel).
2877817 (1106963)

•
•

A problem that caused an X020 syntax error on SELECT DISTINCT (TRIM)has been fixed.
3105393 (1109324)
A problem that prevented the XDB engines to successfully process a COUNT(DISTINCT expression)
scalar function when the expression was a concatenated expression enclosed in parentheses has been
fixed.

•

2884227 (1107903)
A problem that caused a thread stack overflow on scalar function recursions that use CONCAT has
been fixed.

•

2884046 (1107882)
A problem with the XUTLB LOAD grammar prevented the reserved word DATE from being used as a
table name. This has been fixed.

•

2882727 (1107652)
An problem when correlating a subquery produced a PDMP242 error. This has been resolved.

•

2880672 (1107367)
A problem that caused a FETCH FIRST clause in a scalar subquery to be ignored has been fixed.

•

2880671 (1107366)
A problem using the reserved word DOCUMENT as an identifier in the first argument of a scalar
function has been fixed.

•

2874154 (1106483)
CAST AS TIMESTAMP using the special character 'T' as the date/time delimiter was not allowed. This
is now allowed.

•

2874153 (1106484)
An issue with the ordering of a result set caused the incorrect row to be returned on a FETCH FIRST
ONLY clause. This has been fixed.

•

2873390 (1106435)
An issue with index optimization of LIKE predicate processing has been resolved.

•

2873389 (1106391)
A problem that sometimes caused the XDB Server to shut down before completing location checkpoint
operations by maintenance threads has been resolved.

•

2847090 (1102750)
An problem with LIKE predicate index query optimization that caused missing result set rows has been
fixed.

•
•
•

2841168 (1101910)
A problem that prevented the restoration of LOB data from a record with an LOB column after deleting
the record and then rolling back from a Save Point has been fixed.
XDBMONN has been updated to issue the correct error message when it is started, but the server is
not running.
The server Name be displayed in the status bar of the XDB SQL Wizard.
2865763 (1105197)
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•

•
•
•

•

Using ALLOW EDITING on an SQLWizard result set could result in the query being corrupted. This has
now been fixed.
2865336 (1105171)
The restriction that prevented the editing of result sets generated from alias tables has been removed.
2857585 (1104067)
When the SQLWizard is invoked by MFA Drag & Drop to import unload data to a table it no longer
returns an X352/X95 error.
A problem that sometimes occurred when using the DB2(NOHCO) compiler directive option caused the
return of incorrect codes at completion of program execution. This has been fixed.
3100172 (1108872)
The DB2 preprocessor has been updated with a new DB2 compiler directive option, QUALIFY-CALL,
that works with the QUALIFIER compiler directive option to qualify DB2 EXEC SQL CALL statements
with the schema name specified by the DB2 QUALIFIER directive.

•

2884948 (1108032)
The DB2 ECM has been updated to prevent an undefined ECM error when indicator variable arrays are
used in SELECT SQL statements.

•

2884605 (1107947)
The DB2 ECM preprocessor has been updated to support host variables defined as SQL TYPE IS XML
AS BLOB-FILE/CLOB-FILE/DBCLOB-FILE.
2839654 (1101707)

XML Support
Back to the list
•

XMLPARSE no longer returns -19 in XMLSS mode.

•

2913116 (1108661)
Opened XML files are now closed when the COBOL program called by JCL is terminated.

•

•

2885450 (1108132)
A new directive "OUTENC(INPUT)" is created to ensure encoding of the output text will be the same as
the input encoding specified in the XML declaration.
2870879 (1106332)
XMLIO now handles REDEFINE data items correctly.
2795744 (1096302)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2884374 (1107928)
2875256 (1106645)
2871954 (1106649)
3103304 (1109198)
2857117 (1106716)
3106240 (1109462)
2989573 (1108689)
2874306 (1106666)
2848671 (1102872)
2878662 (1107084)
2864100 (1104959)
3101450 (1108990)
2884755 (1107973)
2884754 (1108098)
2883962 (1108118)
2883962 (1108119)
2878826 (1107101)
2878227 (1107012)
2877589 (1106938)
2875248 (1106679)
2874812 (1106627)
2874077 (1106516)
2872027 (1106210)
2869739 (1105894)
2868086 (1105954)
2864170 (1105040)
2864164 (1105035)
2990780 (1108760)
2884757 (1108096)
2883769 (1107830)
2851153 (1103313)
3101883 (1108971)
3101148 (1108902)
2885725 (1108103)
2884537 (1107964)
2878485 (1107076)
2876638 (1107036)
2872931 (1106328)
2872035 (1106199)
2867270 (1106437)
2837526 (1104757)
3101467 (1109005)
2879947 (1107389)
2879908 (1107247)
2878412 (1107371)
2852872 (1107046)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2989831 (1108862)
2875722 (1106767)
2875245 (1106642)
2858289 (1104218)
2839585 (1102006)
2869862 (1105851)
2857086 (1104025)
2831639 (1100766)
3102063 (1108996)
3101684 (1108956)
2884727 (1108008)
2881493 (1107488)
2860914 (1104582)
3105709 (1109380)
3105708 (1109382)
3105707 (1109383)
3105704 (1109377)
3105703 (1109374)
3105221 (1109372)
3105219 (1109379)
3105218 (1109371)
3105217 (1109375)
3105217 (1109376)
3105216 (1109370)
3105215 (1109368)
3105214 (1109369)
3104634 (1109245)
3103928 (1109267)
3103824 (1109284)
3102104 (1109041)
3101976 (1109010)
3101690 (1109039)
3101030 (1108911)
3101028 (1108930)
3101027 (1108932)
3100325 (1108856)
2988233 (1108531)
2912393 (1108452)
2912391 (1108451)
2912389 (1108442)
2912387 (1108439)
2912355 (1108501)
2912354 (1108450)
2887976 (1108736)
2887970 (1108418)
2887419 (1108331)
2886979 (1108286)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2879488 (1107196)
2877587 (1106984)
2877474 (1106937)
2877189 (1106921)
2874594 (1106590)
2874591 (1106575)
2874313 (1106592)
2873877 (1106610)
2872737 (1106316)
2872474 (1106964)
2871631 (1106297)
2869907 (1106670)
2869898 (1106147)
2869892 (1105900)
2869763 (1105896)
2864092 (1106070)
2852872 (1103790)
2852872 (1106311)
2852872 (1107278)
2799183 (1096680)
2991138 (1109121)
2875556 (1106727)
2873522 (1106485)
3101858 (1109029)
2883840 (1107954)
2882062 (1107704)
2871525 (1106466)
3106697 (1109529)
3109683 (1109781)
2871797 (1106201)
2816310 (1104173)
3100167 (1108936)
2989831 (1108879)
2796532 (1096369)
3105586 (1109338)
3105375 (1109313)
3102818 (1109347)
2875983 (1106861)
2875103 (1106822)
2988894 (1108994)
2870824 (1106018)
2875885 (1106721)
2886300 (1108160)
2883994 (1108116)
2876768 (1106926)
2875396 (1106686)
2887853 (1108380)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2881573 (1107673)
2878429 (1107279)
2876370 (1107219)
2871569 (1106143)
2867842 (1105600)
2867117 (1105493)
2853200 (1103409)
2885043 (1108044)
2876773 (1106847)
2869095 (1105803)
2865595 (1105786)
2860304 (1104472)
2883686 (1107844)
2865350 (1105129)
2864599 (1105025)
2873863 (1106487)
2870740 (1106000)
2866084 (1105259)
2864758 (1105772)
2989939 (1108666)
2878067 (1106990)
2877643 (1107028)
2873883 (1106635)
2819070 (1099603)
2657473 (1090356)
2869213 (1105788)
3103252 (1109178)
3103241 (1109176)
2991312 (1108795)
2887454 (1108358)
2882453 (1107614)
3100079 (1108823)
2887733 (1108399)
2880976 (1107464)
2877232 (1106950)
3102272 (1109059)
3101639 (1109086)
2886684 (1108370)
2884612 (1108024)
2879358 (1107190)
2878631 (1107110)
2877721 (1106966)
2876808 (1106856)
2876719 (1106845)
2875613 (1106730)
2873607 (1106420)
2873447 (1106429)
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•
•
•
•
•
•
•
•
•
•
•
•
•
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2851640 (1103228)
2603382 (1087028)
2871769 (1106474)
2876285 (1106842)
3107224 (1109628)
2880556 (1107803)
2879876 (1107263)
2880593 (1107378)
3105620 (1109342)
2991280 (1108799)
2882386 (1107606)
2881902 (1107890)
2879176 (1107150)
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•
•
•
•
•
•
•
•
•
•
•
•

2885859 (1108130)
2885529 (1108083)
2884236 (1108000)
2883551 (1107800)
2881659 (1107500)
2881243 (1107455)
2881040 (1107414)
2881038 (1107416)
2881037 (1107419)
2881036 (1107423)
2880647 (1107399)
2879819 (1107333)

•
•
•
•
•
•
•
•
•
•
•
•

2883907 (1107872)
2874406 (1106565)
2873249 (1106552)
2871661 (1106145)
2863482 (1104862)
2848848 (1102895)
2866216 (1105926)
2883667 (1107815)
2880475 (1107343)
2871842 (1106178)
3102432 (1109463)
2887808 (1108624)

•
•
•
•
•
•
•
•
•

2873158 (1106378)
2873035 (1106735)
2871178 (1106125)
2870557 (1106194)
2865051 (1105317)
2859144 (1104286)
2146936 (1059549)
2876653 (1106832)
2865001 (1105155)

Unsupported Functionality
The following features or functionality are no longer supported:
•

The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
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Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements for Visual COBOL for Eclipse (Windows)
Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are, approximately:
Visual COBOL
2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.
z/Server requirements
z/Server has the following hardware requirements:
•

IBM mainframe model z9 or later is required for installing and using z/Server. z/Server will not install on
earlier hardware models.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•

•
•
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Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file
does not install some of the components. See Issues with the Installation in Known Issues and
Restrictions.
Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.
The Enterprise Server feature is not supported on Windows XP.

Software requirements
Note: This product includes OpenSSL version 1.0.2j.
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Eclipse requirements
•

The setup file installs Visual COBOL and the 64-bit Eclipse 4.6.0.
Some earlier versions of Eclipse are also supported. See Installing Visual COBOL into other instances
of Eclipse in the Advanced Installation Tasks.
Note: If you are installing Visual COBOL into Eclipse 4.5, or 4.6, you must install the Eclipse
Target Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):

•
•

1. Click Help > Install New Software in Eclipse and add a new repository for the location
http://download.eclipse.org/tm/updates/4.0.
2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.
Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit Windows, the setup file does
not install some of the components. See Issues with the Installation in Known Issues and Restrictions.
Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.

Software requirements
•

•

•

Oracle's Java Platform (64-bit) version 1.8.92 or above is required to run the Eclipse IDE. Java 7 and 8
(32 or 64-bit versions) are supported for executing JVM COBOL code and for native COBOL and Java
interoperability. You can download Oracle's Java EE from Oracle's web site and install it anywhere on
your machine.
Note: If Java 7 is installed on your machine, you can skip installing Java 8. Run the setup file with
the skipjre=1 command line option to do this.
Visual COBOL requires:
• A 32-bit Java installation if using the 32-bit Eclipse.
• A 64-bit Java installation if using the 64-bit Eclipse.
The setup file also installs .NET Framework v4.6.2 and the Microsoft's Visual C++ 2010 and 2012
Redistributables.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
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Additional Software Requirements on Windows
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.
Click here to see this information in the Micro Focus Infocenter.

Product Co-Existence
Note: The following applies to Windows only.
•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:
•
•

Visual COBOL and Enterprise Developer cannot coexist on the same machine.
You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

On UNIX
System Requirements for Visual COBOL for Eclipse (UNIX)
Hardware Requirements for Visual COBOL for Eclipse
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

the installation

running

license
server

the product
x86-64
running Red
Hat Linux

Micro Focus

1.02 GB

4.06 GB

2.03 GB

44 MB

x86-64
Micro Focus
running SUSE
SLES

1.02 GB

4.08 GB

2.04 GB

44 MB

Operating Systems Supported
Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Software Requirements
Eclipse requirements
•

•
•

The setup file installs Visual COBOL and the 64-bit Eclipse 4.6.0. After the installation, you can install
Visual COBOL as a plug-in into other Eclipse installations available on the same machine. The
supported versions are 4.4, and 4.5 for both the 32-bit and the 64-bit Eclipse. See Installing Visual
COBOL into other instances of Eclipse.
Visual COBOL supports the 64-bit Eclipse IDE as default and requires a 64-bit Java installation.
Visual COBOL supports both the 32-bit and the 64-bit Eclipse. You can use the 64-bit Eclipse to create
both 32-bit and 64-bit applications.
Note: If you are installing Visual COBOL into Eclipse 4.5, or 4.6, you must install the Eclipse Target
Management plugins into the Eclipse IDE for Java EE Developers package (32-bit):
1. Click Help > Install New Software in Eclipse and add a new repository for the location http://
download.eclipse.org/tm/updates/4.0.
2. Expand RSE 3.8 Main Features, check RSE Terminals UI (Deprecated) and complete the
installation of the plugin.

Other software requirements
Before installing this product, you must have the following software installed on your computer:
•

The unzip utility is required by the setup file.

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries - the 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

•

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 11 1

SUSE 12

Red Hat 6.x

Red Hat 7

glibc

glibc-*.i686 glibc*.x86_64

glibc*.s390

X

X

libgcc

libgcc*.i686

libgcc*.x86_64

libgcc*.s390

X

X

libstdc++

libstdc++*.i686

libstdc++*.x86_64

libstdc++*.s390

X

X

glibc-locale glibcglibclocale-32bit locale-2

N/A

X

gtk2

N/A

libgtk-2_00-2

N/A

X

gtk2

N/A

gtk2tools-2

N/A

X

gtk2

N/A

libXcompos N/A
ite1-0

X

gtk2

N/A

libgdk_pixb N/A
uf-2_0-0-2

X
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Library

32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 11 1

SUSE 12

Red Hat 6.x

Red Hat 7

X

X

gtk2

N/A

gdk-pixbuf- N/A
queryloaders-2

X

gtk2

N/A

libjasper1-1 N/A

X

gtk2

N/A

gtk2*.x86_64

N/A

gtk2-x11

N/A

libgthread2_0-0-2

N/A

X

libXtst

N/A

libXtst6-1

N/A

X

libXtst

N/A

libXtst*.x86_64

N/A

X

X

glibc-devel

glibc-devel- glibc-devel- N/A
*.i686
*.x86_64

X

X

PackageKit N/A
-gtk

PackageKit N/A
-gtkmodule*.x86_64

X

PackageKit N/A
-gtk3

PackageKit N/A
-gtk3module*.x86_64

gtk2engines

N/A

gtk2N/A
engines.*.x
86_64

X

libcanberra N/A
-gtk2

libcanberra N/A
-gtk2*.x86_64

X

webkitgtk

N/A

webkitgtk.x N/A
86_64

X

webkitgtk3

N/A

webkitgtk3. N/A
x86_64

xterm

Any
version

Any
version

Any
version

X

X

X

X

unzip

Any
version

Any
version

Any
version

X

X

X

X

libgnome

N/A

libgnome.x
86_64

N/A

X

X

X

X

X

Note: 1 To install Eclipse on SUSE 11 you must have installed SuSe 11 Service Pack 3 or later.
* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.
** Operating system libraries required for PL/I support on both SUSE and Red Hat.
Visit the Red Hat Web site for more information.

42

| Installation

•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

Oracle's Java Platform (64-bit) version 1.8.92 or above is required to run the Eclipse IDE. Java 7 and 8
(32 or 64-bit versions) are supported for executing JVM COBOL code and for native COBOL and Java
interoperability. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on
your machine.
Note: On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java.
When you start the installation, if the 32-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevents you from installing both the 32-bit and the 64-bit versions
of Java on the same machine. To work around this problem:
•
•
•

Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 32-bit Java version. For
example, untar in /usr/local/java64 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to
install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:
•

•
•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 64-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file.
Click here to see this information on the Micro Focus Infocenter.
Browser
Back to Top
Browser versions which can be used for embedded browser support (such as SWT) and their
corresponding Eclipse versions are listed here.
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Note: Eclipse 4.5 and newer support Mozilla 1.4 GTK2 - 1.7.x GTK2, XULRunner 1.8.x - 1.9.x, 3.6.x,
10.x, 24.x and 31.x (but not 2.x nor other unlisted versions), WebKitGTK+ 1.2.x and newer (Eclipse
4.5 support for XULRunner 31.x is not available on Linux due to Bug 467646.). For Eclipse 4.6 you
must install a 64-bit browser version.

UNIX and Linux Installer Issues
Installing on Linux
On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:
•
•
•

Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 32-bit Java version. For example,
untar in /usr/local/java64 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and
run Visual COBOL.

Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify EDadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks in your product Help.

On Windows
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Installing on Windows
Note:
•
•

This version of the product is a full install.
If you have an earlier version of Visual COBOL installed on your machine, check Installing as an
Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:
1. Run the vce_30.exe file and follow the wizard instructions to complete the installation.
By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.6 64-bit, with the Micro Focus plugins already
installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.
The setup file installs any missing prerequisite software as listed in the topic Software Requirements.
Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have a more recent Java 8 update version installed on your machine and you want to
skip installing Java 8 update 102, run the setup file from the command line with the skipjre=1
command line option.

On UNIX
Installing the software
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_deveclipse_3.0_platform
2. Run the setup file with superuser permissions:
./setup_visualcobol_deveclipse_3.0_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_visualcobol_deveclipse_3.0_platform -installlocation="full path of
new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter
the -help option.
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Note:
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the skipsafenet option, which skips the installation of SafeNet:
. /setup_visualcobol_deveclipse_3.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Setting up the environment
When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
. /opt/microfocus/VisualCOBOL/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V
Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.
To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product
To start Eclipse:
•

•

If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).
Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh
If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:
eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.
The advanced installation tasks include:
•
•
•
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Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

•
•

Installing into other instances of Eclipse - available in the product Help and in the Micro Focus
Infocenter
Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus
Infocenter

See this information in the Micro Focus Infocenter - for Windows click here and for UNIX click here.

On Windows
Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

If you have been using the mainframe components of , see Installing z/Server as an Upgrade for
recommendations about how to upgrade your z/Server installation. Also, check Backward Compatibility
of AWM Models for information about changes that affect your existing AWM models.

•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Visual COBOL Installation Options
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.
To see what parameters you can use, execute the following from the command line:
install-file /help
where install-file for the following products is as follows:
Visual COBOL

vce_30.exe

See the Examples section further in this topic for examples of some of the parameters you can use.
Directory considerations
•
•

You must have read and write access for every directory accessed during the installation.
You can override the default installation folder using the InstallFolder parameter.

•

Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:
/log drive:\path\LogFilename

Installing silently
Use the /q parameter to install silently:
start /wait install-file.exe /q [parameters]

Installation

| 47

Examples
•
•
•

To silently install Visual COBOL into a directory other than the default:
start /wait vce_30.exe /q InstallFolder=c:\DirectoryName
If you want to silently install the Eclipse IDE in a location other than the default, execute:
start /wait vce_30.exe /q InstallFolder2=c:\EclipseInstallDirectory
To skip installing JRE when installing Visual COBOL:
start /wait vce_30.exe /q skipjre=1

On UNIX
Installing as an upgrade
This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it.
Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL installer with the –installlocation option:
1. Execute the following command:
. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL_eclipse"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/VisualCOBOL/bin/cobsetenv
Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_visualcobol_deveclipse_3.0_platform -installlocation="full path of
new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter the help option.
Skip Java Check
To skip the Java version check, use the -skipjavachk option. This skips the parts of the installation that
require Java, for example, the Eclipse installation. This can be used when you do not have Java on your
path and want to perform a custom installation. You can then manually configure the plug-ins as required:
./setup_visualcobol_deveclipse_3.0_platform -skipjavachk
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Skip Installing Eclipse
To skip the installation of Eclipse, use the -skipeclipse option. This enables you to install Visual
COBOL into your own version of Eclipse.
./setup_visualcobol_deveclipse_3.0_platform -skipeclipse
Note: You need to install the COBOL plug-ins manually.

Installing into a 32-bit Version of Eclipse
To skip the installation of the shipped Eclipse version but still install the plug-ins, use the -32bit option.
This enables you to install your own 32-bit version of Eclipse and manually install the required Visual
COBOL components.
./setup_visualcobol_deveclipse_3.0_platform -32bit
Configuring Enterprise Server
You can use the following options to configure the Enterprise Server installation: [ ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f
You can use the following command line arguments to install silently on UNIX/Linux:
–silent -IacceptEULA
For example, execute:
[as root] setup_filename –silent -IacceptEULA

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows
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Configuring Visual COBOL
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product.
To install ViewNowX:
1. Using Windows Explorer, navigate to the folder that contains the ViewNowX executable. By default, this
is %ProgramFiles(x86)%\Micro Focus\Visual COBOL\ViewNowX.
2. Execute ViewNow_X_Server.exe and then vnx_HF_11327.msp in that folder.
ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing on Windows
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.
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To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall

On UNIX
Configuring Visual COBOL
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:
1. Open the existing workspace with this product.
You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on
UNIX
Note:
•
•

If you are working with remote projects, you need to configure the environment before you start the
remote server process.
On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.
Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate
linker options for the platform and the COBOL working mode:
To do this, execute the following at the command line:
$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
1. Execute as root the Uninstall_VisualCOBOLEclipse3.0.sh script in the $COBDIR/bin directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•

•
•
•

When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.
If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows
Windows 7 and Earlier

•

From your desktop, click Start > All Programs > Micro Focus
License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

•

From the Start screen, click the License Administration tile

Windows 10 and Later

•

Click Start > Micro Focus License Manager > License
Administration

UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a 16digit string of letters and numbers.
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If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
1.
2.
3.
4.
5.
6.

Start Visual COBOL.
Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
Ensure I have a full Visual COBOL license is checked.
Click Browse next to the License file field.
Select the license file (which has an extension of .mflic), and then click Open.
Click Finish to install the license.

UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
UNIX
1. Start Micro Focus License Administration.
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2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.
The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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